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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its

majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
o power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.

e The useris advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Application Leading Tool
(Code Generator) for RX together with the CS+ IDE to create a working project for the RSK platform. It is
intended for users designing sample code on the RSK platform, using the many different incorporated
peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into CS+, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX24U microcontroller may be found in the Hardware Manual and within the provided sample
code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX24U Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Description Document Title Document No.
Type

User’s Manual Describes the technical details of the RSKRX24U User’s Manual R20UT3758EG
RSK hardware.

Tutorial Manual Provides a guide to setting up RSK RSKRX24U Tutorial Manual R20UT3759EG
environment, running sample code and
debugging programs.

Quick Start Provides simple instructions to setup the RSKRX24U Quick Start Guide R20UT3760EG

Guide RSK and run the first sample.

Code Generator Provides a guide to code generation RSKRX24U Code Generator R20UT3761EG

Tutorial Manual and importing into the CS+ IDE. Tutorial Manual

Schematics Full detail circuit schematics of the RSK. RSKRX24U Schematics R20UT3757EG

Hardware Provides technical details of the RX24U RX24U Group Hardware RO1UHO658EJ

Manual microcontroller. Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVD Digital Versatile Disc

E1/E2 Lite Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

PLL Phase-locked Loop

Pmod™ Thi§ is a Digilent Pmod™ qupatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Real Time Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

uUSB Universal Serial Bus

WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.
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RSKRX24U
RENESAS STARTER KIT

R20UT3761EG0100
Rev. 1.00
Nov 30, 2016

1. Overview

11 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to use the CS+ IDE

code generator plug in to create a working project for the RSK platform.

1.2 Features

This RSK provides an evaluation of the following features:
« Project Creation with CS+

« Code Generation using the code generator plug in.
« User circuitry such as switches, LEDs and a potentiometer

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3761EG0100 Rev. 1.00 NS
Nov 30, 2016 RENES

Page 7 of 57



RSKRX24U 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the code generator plug in for the RX family
together with the CS+ IDE to create a working project for the RSK platform. The tutorials help explain the
following:

e Project generation using the CS+

e Detailed use of the code generator plug in for CS+
e Integration with custom code

e Building the project CS+

The project generator will create a tutorial project with three selectable build configurations:
e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
e ‘Debug’is a project built with the debugger support included. Optimisation is set to zero.

o ‘Release’ is a project with optimised compile options (level two) and no outputs debugging information
options selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

R20UT3761EG0100 Rev. 1.00 NS Page 8 of 57
Nov 30, 2016 :{ENES




RSKRX24U 3. Project Creation with CS+

3. Project Creation with CS+

3.1 Introduction

In this section the user will be guided through the steps required to create a new C project for the RX24U
MCU, ready to generate peripheral driver code using Code Generator. This project generation step is
necessary to create the MCU-specific project and debug files.

3.2 Creating the Project

To use the program, start CS+:
Windows™ 7 & Vista: Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC
(RL78,RX,RH850)

Windows™ 8.1 & 8: From Apps View @ click ‘CS+ for CC (RL78,RX,RH850)’ icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics CS+ > CS+ for CC (RL78,RX,RH850)

e CS+ will show the Start Page. Use the Create New Project
‘GO’ button to Create a New Project. Anew project can be created

A new project can also be created by reusing the file configuration registered to zn existing project.

e In the ‘Create Project’ dialog, select Create Project =
‘RX* from the ‘Microcontroller’ pull- Micracongaller RX [=]
dOWﬂ . Using microcontroller:

e In the ‘Using Microcontroller’ list s (seareh merecaniller Updne
control, scroll down to ‘RX24U’ and - 2oas o i

m| »

M R5F524UB4xFB(144pin) On-chip ROM size[KBytes]:512

" . On-chip RAM size[Bytes]:32768
REF524/82FP(100pin] Addtional Information:Package=PLOPO144KA-A

expand the tree control by clicking ‘+'.
Select ‘R5F524UEAXFB(144pin)'.

R5F524UCAFE(144pin)
REF524UCAxFP(100pin)

e Ensure that in the ‘Kind of project’ pull- - ] REFS2AUSC R0 ]
down, ‘Empty Application(CC-RX) is s 2
selected. Kind of project Empty Application(CC-RX) =l
e Choose an appropriate name and ot G Tutorel
location for the project, then click e rkspace =]
‘Create’. Make the project folder

C-\WworkspacelCG_Tutorial\CG_Tutorial mtpj

Note: this tutorial assumes the project
is named and located at the place
shown opposite. Broject lobo passed Brouse

[] Pass the file composition of an existing project to the new project

Copy compasition files in the diverted project folder to @ new project folder.

e If the folder entered cannot be found a
‘Question’ dialogue will be displayed; [

. Crezste ] [ Cancel ] [ Help
click 'Yes'.
e CS+ will create the blank project with CG_Tutorial - C5+ for CC - [Property]
the standard project tree. A ‘Code File Edit View Project Build Debug Tool Window Help
Generator’ node may also be shown, if Bsat | ARG X BB O BE S

previously enabled. Enable Code
Generator can be seen in section 4.2.

@ SolutionList : [0 &0 @@ &) | &
o

Project Tree x
P © 8@
B_ﬂ CG Tutorial (Project 4 Generate File Mode
M R5F524UEAFB (Microcontroller) AP output control

ode Generator (Design Toel) Text file encoding
Ay, CC-RX (Build Tool) Creation date

i, R Simulator (Debug Teol) Output folder
" [P File File generation control
Register files
Report type
R20UT3761EG0100 Rev. 1.00 Page 9 of 57
Nov 30, 2016 RENESAS




RSKRX24U 4. Code Generation Using the CS+ plug in

4. Code Generation Using the CS+ plug in

4.1 Introduction

Code Generator is a Windows™ GUI tool for generating template ‘C’ source code and project settings for the
RX24U. When using Code Generator, the user is able to configure various MCU features and operating
parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to sections of the
Hardware Manual.

By following the steps detailed in this tutorial, the user will generate a CS+ project called CG_Tutorial. A fully
completed Tutorial project is contained on the DVD and may be imported into CS+ by following the steps in
the Quick Start Guide. This tutorial is intended as a learning exercise for users who wish to use the Code
Generator to generate their own custom projects for CS+.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the user is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-visit
Code Generator to change any MCU operating parameters.

The CG_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion and display the
results via the Virtual COM port to a terminal program and also on the LCD display on the RSK.

Following a tour of the key user interface features of Code Generator in §4.3, the reader is guided through
each of the peripheral function configuration dialogs in §4.4. In §5, the reader is familiarised with the structure
of the template code, as well as how to add their own code to the user code areas provided by the code
generator.

4.2 Enabling Code Generator

After installation of CS+, Code Generator must be enabled. This step is only required once, CS+ will
remember this setting on subsequent launches.
From the ‘Tool’ pull-down menu select ‘Plug-in Setting...”. On the ‘Additional Function’ tab, click the box next to
the ‘Code Generator/Pin View Plug-in’ option and ensure it is ticked:

Addttional Function

Module Name Description

= E,_'r' Debug Console Plug-in DebugConsole plug-n to support using standard 1/0.

Click ‘OK’. CS+ needs to restart to enable this selection, select “Yes’ from the Question dialogue box.
After restarting, ‘Code Generator (Design Tool)' node will now be shown in the left-hand ‘Project Tree’ window
pane.

€6 _Tutorial - C5+ for CC - [Property]
File Edit View Project Build Debug Tool Window Help
& start | [J B @ ;X Hay B0 58 R A

(@ solutionList [0 @ @ B | 5
Project Tree 2 x
@02 @

% Cods Generator Property
4 Generate File Mode

= [ €6 Tutorial (Project)

8 RSF524UEAXFE (Microcontroller)
#{Code Generator (Design Toal) | Text file encoding
4, CC-RX (Build Tool) Creation dste
2= RX Simulator (Debug Tool) Output folder
File File generation central
Register files
Report type
R20UT3761EG0100 Rev. 1.00 - QEN ESNS Page 10 of 57

Nov 30, 2016



RSKRX24U

4. Code Generation Using the CS+ plug in

4.3

Code Generator Tour

This section presents a brief tour of Code Generator. For further details of the Code Generator paradigm and
reference, refer to the Application Leading Tool Common Operations manual.

You can download the latest document from: https://www.renesas.com/applilet
Application Leading Tool is the stand-alone version of Code Generator and this manual is applicable to the

Code Generator.

In the Project Tree pane, click on the icon next to ‘Code Generator’ node to expand the list.

Expand the ‘Peripheral Functions’ node by clicking on the next to it.
Open the ‘Peripheral Function’ tab by double clicking on the ‘Peripheral Functions’ name.
The CS+ main window will now contain a ‘Peripheral Functions’ tab with the Initial View as show in Figure 4-1.

@ CG_Tutorial - CS+ for CC - [Peripheral Functions]

File Edit Miew Project Build Debug Tool Window Help

||l

X By o | 8 & Z @ B Defaultbuild A @ @ ®E" E SEEE P Bt | [ JHG 0P E G S g Solution List
Froject Tree £3 Praperty |ﬁ_‘| Peripheral Functions [=[3¢]
; ©3.@ — — —
- = . %] GererateCode | % (3 o8 = of M 3 D & O DD & F o F I G S M2
=% C6 Tutorial (Project) - .
& RSFS24UEAXFE (Microcontroller) : Cloolc setting | Block diagram |
= JCndeGanEratur(DEswgnTnn\] Main clock escillator setting
(-2 Pin View Operation
ol Peripheral F Main clock escilation source Rescnator -
ol :
W' Voltage Detection Circuit Frequency 8 MRz} E
-8 Clock Frequency Accuracy Mea Oscilator watt time 8192 cycles - 2048 (us)
& Low Power Consumption
& Interrupt Contraller Unit Oscilation stop detection function Disabled -
W B
uses High speed clock escillator (HOCO) setting
W' Data Transfer Controller Ho
¥ 0 Ports SEE
W Multi-Function Timer Pulse Uni 32 MHz
& Port Output Enable 3 1
- W General PWM Timer
W §-Bit Timer PLL circuit setting
- W' Compare Match Timer [ Cperation
W' Independent Watchdog Timer R e oy
- W Serial Communications Interfac
& 12C Bus Interface x1
.. Serial Peripheral Interface w8
&' CRC Calculator
- 12-Bit A/D Converter 64
- ' DJA Converter S
' Comparator C Output 7 x
~..! Data Operation Circuit zoF]
42l Code Preview
A, CC-RX (Build Tool)
&= RX Simulator (Debug Tool)
j File
'\ All Messages / -
‘ i 2 v || =2 output [@ Smart Browser [B Error List
F1 Fa = P4 s & F1 ] [lF2 FPFullscreen | F17 =
12 DISCONNECT

Figure 4-1 Initial View

Code Generator provides GUI features for configuration of MCU subsystems and peripherals. Once the user
has configured all required MCU subsystems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured CS+ project.

Navigation to the MCU peripheral configuration screens may be performed by double-clicking the required
function in the Project Tree -> Project Name -> Peripheral Function on the left.

It is also possible to see a preview of the code that will be generated for the current peripheral function
settings by double-clicking the required function in the Project Tree -> Project Name -> Code Preview on the
left.

R20UT3761EG0100 Rev. 1.00
Nov 30, 2016

RENESAS Page 11 of 57
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RSKRX24U 4. Code Generation Using the CS+ plug in

44 Code Generation

In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple project
containing interrupts for switch inputs, timers, ADC and a SCI.

441 Clock Generator

Figure 4-2 shows a screenshot of Code Generator with the Clock Generator function open. Click on the
‘Clock setting’ sub tab. Configure the system clocks as shown in the figure. In this tutorial we are using the
on board 20 MHz crystal resonator for our main clock oscillation source and the PLL circuit is in operation.
The PLL output is used as the main system clock and the divisors should be set as shown in Figure 4-2.

%] GenerateCode | = [0 & = @ W 5 30 D 0 D D & T #3 F I G b M 2

Clock setting i Block diagram |
Main clock oscillator setting
Operation
Main clock oscillation source Resanator -
Frequency I2E' I (MHz)
Oscillator wait time 8152 cycles - 2048 (us)
Oscillation stop detection function Dizabled -
High speed clock oscillator (HOCO) setting

[7] Operation

32 MHz

142

PLL circuit setting
PLL clock source Main clock escillator -
Input frequency division ratio I x 12 - I
Frequency multiplication factor x 8 -
Frequency 80 (MHz)
Low speed clock escillater (LOCO) setting
|| Operation |
System clock setting
Clock source I PLL circuit - I
System clock (ICLE) w1l - 20 (MHz)
Peripheral module clock (PCLKA) x1 - B0 (MHz)
Peripheral module clock (PCLKE) 0 (MHz)
Peripheral module clock (PCLKD) a0 {MHz)
Flash IF clock (FCLK) 20 (MHz)
[WDT-dedicated low-speed clock escillator (IWDTLOCO) setting

[7] Operation

15

Figure 4-2 Clock setting tab
R20UT3761EG0100 Rev. 1.00 RENESAS Page 12 of 57

Nov 30, 2016



RSKRX24U

4. Code Generation Using the CS+ plug in

Proceed to the next section on ‘Interrupt Controller Unit’.

name in ‘Peripheral functions’ on the Project Tree.

Project Tree
? © 2| [@

Double clicking on the ‘Interrupt Controller Unit’

= CG Tutorial (Project)*

----- % RSF524UEAXFB (Microcontroller)
[-jn_,_j Code Generator (Design Tool)
-7 Pin View

Eliﬂ Peripheral Functions

..... & Clock Generator

- Voltage Detection Circuit

..... &' Low Power Consumption
..... [ Interrupt Controller Unit
..... ' Buses

..... &' Data Transfer Controller
D- /O Ports

..... &' Port Output Enable 3
W General PWM Timer
[ 8-Bit Timer

- Compare Match Timer

..... W' 12C Bus Interface

..... W' Serial Peripheral Interface
..... ' CRC Calculater

- 12-Bit A/D Converter

..... &' DfA Converter

- Comparator C

..... W' Data Operation Circuit

..... B Clock Frequency Accuracy Measurement Circuit

- ® Multi-Function Timer Pulse Unit 3

..... W' Independent Watchdog Timer
- Serial Communications Interface

Figure 4-3 Select Interrupt Controller Unit

R20UT3761EG0100 Rev. 1.00
Nov 30, 2016

RENESAS
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RSKRX24U 4. Code Generation Using the CS+ plug in

442 Interrupt Controller Unit

Referring to the RSK schematic, SW1 is connected to IRQ0 (P10) and SW2 is connected to IRQ4 (P60).
SWa3 is connected directly to the ADTRGOn and will be configured later in §4.4.4. Navigate to the ‘Interrupt
Controller Unit’ node in Code Generator and in the ‘General’ tab, configure these two interrupts as falling edge
triggered as shown in Figure 4-4 below.

% Property |E,:£ Peripheral Functions®

%] GenerateCode | = [ F B # ¥ 2 =D O D O £ 5 o4 7 G 9 =

- Fast interrupt setting

[ Fast intemupt mtemupt source | BSC (BUSERR vect=16)
- Software interrupt setting
[ Software intemupt Friority | Level 15 (highest)
—~NMI setting
[] NMI pin intemupt zlid edge | Falling Digital fiter | Mo filter 0 Hz
~IRQ0 setting
Fin P10 ~  Datalfter Nofilier 1[0 MHz
Valid edge | Falling M | Prioity Level 15 (highest) =
~IRQ1 setting
[T 1Ra1 PFin | P11 Digital filter | Mo filter 0 Hz,
alid edge | Low level Priority | Lewel 15 (highest)
-IRQ2 setting
[l 1Raz2 Pin | PDO Digital fiter | No filter D MHz
alid edge | Low level Priority | Lewel 15 (highest)
-IRQ3 setting
[l 1Ra3 Pin | PB4 Digital fiter | No filter 0 MHz
alid edge | Low level Priority | Level 15 (highest)
- IRG4 setting
Pin §j PE0 - Digital fiter ~ Ne filter ~| |0 MHz
Valid edge [ Falling - Priority  Lewvel 15 (highest) -
—IRG5 setting
[F1] IRaR Fin | P02 Digital fiter | No filter D Hz
alid edge | Low level Priority | Lewel 15 (highest)
~IRQE setting
[T 1IRas PFin | P21 Digital filter | Mo filter D Hz
alid edge | Low level Priority | Lewel 15 (highest)
- IRQ7 setting
[ IRa7 Pin | P20 Digital fiter | No filter 0 Hz
alid edge | Low level Priorit Level 15 (highest)

Figure 4-4 Interrupt Functions tab
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RSKRX24U

4. Code Generation Using the CS+ plug in

Proceed to the next section on ‘Compare Match Timer’. Double clicking on the ‘Compare Match Timer’ name
in ‘Peripheral functions’ on the Project Tree.

Project Tree

: @ 2 [E

-

=1} CG Tutorial (Project)*
----- 5:% RSF524 UEAFE (Microcontroller)

[-jn_;i Code Generator (Design Tool)
A Pin View

Eiﬂ Peripheral Functions

..... @ Clock Generator

-
..... [
..... W
----- & Interrupt Controller Unit

Voltage Detection Circuit
Clock Frequency Accuracy Measurermnent Circuit
Low Power Consumption

Buzes

Data Transfer Controller

/O Ports

Multi-Function Timer Pulse Unit 3
Port Cutput Enable 3

General PWM Timer

8-Bit Tirner

Compare Match Timer

Independent Watchdog Tirner
Senal Communications Interface

! I2C Bus Interface

Serial Peripheral Interface

! CRC Calculater
1 12-Bit A/D Converter

D/A Converter
Comparator C
Data Operation Circuit

[]mﬁ: Code Preview

Figure 4-5 Select Compare Match Timer
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RSKRX24U 4. Code Generation Using the CS+ plug in

443 Compare Match Timer

Navigate to the ‘Compare Match Timer’ node in Code Generator. CMTO will be used as an interval timer for
generation of accurate delays. CMT1 and CMT2 will be used as timers in de-bouncing of switch interrupts.

In the ‘CMTO’ sub-tab configure CMTO as shown in Figure 4-6. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

Property | S5l Peripheral Functions™
[—

] GenerateCode | % 0 & R ¥ B A B O B DD LT FHEGHME
CMTO | cMT1 | cMT2 | cmT3 |
Compare match timer operation setting

Count clock setting

@ FCLK/2 ©) PCLE/32 ©) PCLK/128 ©) PCLK/512

Interval value setting
Interval value |1 I Ims vl {Actual value: 1)

Interrupt setting

Enable compare match intemrupt ({CMI0)

Priority I Lewvel 10 - I

Figure 4-6 CMTO tab

Navigate to the ‘CMT1’ sub-tab and configure CMT1 as shown in Figure 4-7. This timer is configured to

generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Property | £ Peripheral Functions®
—

5] Generste Code | % (3 - o B S 56D B DD RS AT R G b WS

curo] M1l cuT2 [ cuT3 |

Compare match timer operation setting

Count clock setting
@ PCLK/8 @ PCLK/32 @ PCLK/128 (@ PCLK/512
Interval value setting
Interval value IZD I I ms vl (Actual value: 20)

Interrupt setting

Enable compare match intemupt (CMIT)

Priarity | Level 10 - |

Figure 4-7 CMT1 tab

Navigate to the ‘CMT2’ sub-tab and configure CMT2 as shown in Figure 4-8. This timer is configured to

generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Property | S5l Peripheral Functions™
—

] GenerateCode | 5 0 S| W ¥ 4D QDD ST S E KA
[ cumo | cwr1| cMT2 | otz |

Compare match timer operation setting

Count clock setting
@) PCLK/3 @ PCLK/32 @ PCLKA28 @ PCLK/512
Interval value setting
Interval value |2DD I I ms vI (Actual value: 200)
Interrupt setting
Enable compare match intermupt (CMIZ)
Priority | Level 10 -|

Figure 4-8 CMT2 tab
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4. Code Generation Using the CS+ plug in

Proceed to the next section on “12-Bit A/D Converter’. Double clicking on the ‘“12-Bit A/D Converter’ name in
‘Peripheral functions’ on the Project Tree.

-F'rnject Tree

; @ 2| [E

=-| f% CG Tutorial (Project)*

-

----- {E RSF524UELxFE (Microcontroller)
[-]13_,:# Code Generator (Design Tool)
)‘* Pin View

B% Peripheral Functions

----- i*:_‘: Clock Generator

-
..... n

..... W
----- @& Interru pt Controller Unit

Yoltage Detection Circuit
Clock Frequency Accuracy Measurement Circuit
Low Power Consumption

Buses

Data Transfer Controller

/O Ports

Multi-Function Timer Pulse Unit 3
Port Qutput Enable 3

General PWM Tirner

&-Bit Tirmer

Eg---f Cormpare Match Timer

Independent Watchdog Timer

v Serial Communications Interface
! 12C Bus Interface

Serial Peripheral Interface

! CRC Calculataor
tl 12-Bit A/D Converter

D/A Converter
Cornparator C
Data Operation Circuit

EEI---*I ¥ Code Preview

Figure 4-9 Select 12-Bit A/D Converter
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RSKRX24U 4. Code Generation Using the CS+ plug in

4.4.4 12-Bit A/D Converter

Navigate to the “12-Bit A/D Converter’ tab in Code Generator. In the ‘S12AD0’ sub-tab configure S12ADO0 as
shown in Figure 4-10, Figure 4-11 and configure the S12AD0 as shown. We will be using the S12ADO in 12-
bit one shot mode on the ANOOO input, which is connected to the RV1 potentiometer output on the RSK. The
conversion start trigger will be via the pin connected to SW3.

7% Property | 55 Peripheral Functions®

—

f] GenerateCode | % 1 & X # M A D QDD L F TP b
S12AD0 | 512401 | S124D2 |

512400 operation setting
Operation mode setting
@ Single scan mode () Group scan mode () Continuous scan mode
Group scan select
@
Double trigger mode setting
@ Disable () Enable

Self diagnosis setting
Mode Unused -

Disconnection detection assist setting
Charge setting Unused -

Group scan pricrity setting
Group without priority
Mot restarted or continued due to Group pricrity
Restarted from the first scan channel
AD converted value count setting
@ Addition mode () Average mode

Analog input channel setting

Convert Add/Average Programmable gain
(Group A) AD value amplifier

ANDDD & =

ANDDT ]

ANDOZ (]

ANDO3 (]

AND16 ]

Programmable gain amplifier setting

5 A0
20

Figure 4-10 S12ADO0 tab (1)
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RSKRX24U

4. Code Generation Using the CS+ plug in

- Conversion start trigger setting

Conversion start trigger (Group A)
A/D conversion start trigger pin

Co oup B
Compare match with or input capture to MTUD. TGRA

Compare match with or input capture to MTU1.TGRA

ADTRGH pin selection P20 -
- Data regi

AD co addition court 1-time conversion

Data placement Right-alignment -

Automatic clearing Disable automatic clearing

— ANDOD / Self-dizgnosis conversion time setting

Input sampling time 3667 (s} (Actual value:

675)

- ANDO1 conversion time setting

sampling time 3.667 =3 ue: 75
- ANDDZ conversion time setting
3.667 IS 75
3.667 IS 75
- ANO16 conversion time setting
Input sampling time 3.667 1) (Actual value: 3.675
- Conversion time setting
Total conversion time {Group A) 4725 (=)
— Qutput setting
[ ADSTO pin output enable P02
— Interrupt setting
Enable AD conversion end intermupt (S12ADI)
Priority Level 15 (highest) -
E group B (GBAD

Level 15 (highest)

Priority Level 15 (highest)

Figure 4-11 S12ADO tab (2)
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4. Code Generation Using the CS+ plug in

Proceed to the next section on

Project Tree
2 D 8

‘Serial Communications Interface’. Double clicking on the ‘Serial
Communications Interface’ name in ‘Peripheral functions’ on the Project Tree.

El

=-| i CG Tutorial (Project)*

[

----- {% RSF524UEAXFE (Microcontroller)
[-jn;i Code Generator (Design Tool)
)'* Pin View

EE& Peripheral Functions

----- i? Clock Generator
|--W Voltage Detection Circuit

7m0 170 Ports

- Multi-Function Timer Pulse Unit 3
..... &' Port Output Enable 3

-7 General PWIM Timer

- @-Bit Tirner

]H? Compare Match Timer

..... W' Independent Watchdog Timer
s ) Serial Communications Interface
..... ! I2C Bus Interface

..... W' Serial Peripheral Interface

..... W’ CRC Calculator

0@ 12-Bit A/D Converter

..... ' DfA Converter

|- W Comparator C

..... W' Data Operation Circuit

[]_,_;—f Code Preview

Figure 4-12 Select Serial Communications Interface
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RSKRX24U 4. Code Generation Using the CS+ plug in

445 Serial Communications Interface

Navigate to the ‘Serial Communications Interface’ tab in Code Generator, select the SCI9 sub-tab and apply
the settings shown in Figure 4-13. In the RSKRX24U SCI9 is used as an SP| master for the Pmod LCD on
the PMOD1 connector as shown in the schematic.

P4 Property f,_g Peripheral Functions™
—

%] GenerateCode | 22 O K 1= @ M A DA DD LT TFE G ME

scit | scis | scis | scie | scis Jsci |
| General setting | Setting |
Function setting
) Unused
() Asynchronous mode Transmission
() Asynchronous mode (Multi-processor) Transmission
() Clock synchronous mode Transmission
") Smart card inteface mode Transmission
) Simple IIC bus
I Master transmit cnly - I
Fin setting
PG1 PGO
PG1 PGO
SMOSI9 PG1 - PGOD

Figure 4-13 SCI9 General Setting tab

Select the SCI9 ‘Setting’ sub-tab and configure the SPI Master as illustrated in Figure 4-14. Make sure the
‘Transfer direction setting’ is set to ‘MSB-first’ and the ‘Bit rate’ is set to 10000000. All other settings remain at
their defaults.

Property | 25 Peripheral Functions®

—

] GenerateCode | L [0 & [ 4 W6 5 50 ) 2 D D L Foff FE G M2
scit | scis [ sci | scie | scie [ sci |

General setting f Setting

Transfer direction setting

) LSBAirst @ MSBirst

Data inversion setting
@ MNormal ) Inverted

Transfer rate setting

Transfer clock Internal clock - FG2 -
Bit rate I'I[HIH}D'D'D vl bps)  (Actual value: 10000000, Emar - 0%)

[7] Enable modulation duty comection

SCKS pin function Clock output -
Clock setting
Clock delay Cleck is not delayed -

[ Enable clock polarity inversion

[iata handling setting

Transmit data handling Data handled in interrupt service routine -

Interrupt setting
TKIS. TEIS priority Level 15 (highest) -

Callback functicon setting
Transmission end

Figure 4-14 SCI9 Setting tab
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4. Code Generation Using the CS+ plug in

Staying in the ‘Serial Communications Interface’ tab in Code Generator, select the SCI1 sub-tab and apply the
settings shown in Figure 4-15. In the RSKRX24U SCI1 is connected via a Renesas RL78/G1C to provide a
USB virtual COM port as shown in the schematic.

Property | 55 Peripheral Functions®
=

E’ij Generate Code | % [ @& (&

WM E DO DD ST T G S

scit | scis | scis | scie | scis [ scit |

Generalseﬂing§| Setting ‘

—Function setting

() Unused

I Transmission/reception vl

ynchronous mode (Multi-p
() Clock synchronous mode
() Smart card interface mode
) Simple IIC bus

) Simple SP1bus

i] Transmission
Transmission

Transmission

Slave transmitireceive

—Pin setting
T PD3
PC4
PC4

- RXD1 FD5 -

FC3

PC3

Figure 4-15 SCI1 General Setting tab

Select the SCI1 ‘Setting’ sub-tab and configure SCI1 as illustrated in Figure 4-16. Make sure the ‘Start bit
edge detection’ is set as ‘Falling edge on RXD1 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings

remain at their defaults.

Property | £l Peripheral Functions™
[—

'f;;J Generate Code

o Sl - < I T < - = b e R AL S

s | scis | scie [ scie | scie [ scint |

| General seﬂ.mg. m’

- Start bit edge setting

) Low level on RXD1 pin

@ Faling edge on RXD1 pin

- Data length setting

- Noise filter setting

) 9bits @ 8bits () 7bits
- Parity setting

@ None ) Even ) Odd
- Stop bit length setting

@ 1bt ) 2bits
— Transfer direction setting

@ LSBirst (@) MSB-irst
— Transfer rate setting

Transfer clock Internal clock -

zse o 16 cycles for 1-bit period

Bit rate | 9200 -] e (Actual value: 19230.769, Eror 0.16%)

[7] Enable modulation duty comection

SCK1 pin function SCK1 is not used - P25

[] Enable noise fiter

Clock signal divided by 1

- Hardware flow control setting
@ Nong

- Data handling setting

Transmit data handiing
Receive data handiing

- Interrupt setting

Enable emor intemupt (ERI1)
TXI1, RXI1, TEI, ERI1 priority

- Callback function setting

Transmission end

@ CT8 @ RTS
P02
Data handled in interrupt service routine -
Data handled in interrupt service routine -
Level 15 (highest) -
Reception end Reception emor

Figure 4-16 SCI1 Setting tab
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4. Code Generation Using the CS+ plug in

Proceed to the next section on ‘1/O Ports’. Double clicking on the ‘I/O Ports’ name in ‘Peripheral functions’ on

the Project Tree.

Project Tree
2 © 8

2]

E[_f} CG Tutorial (Project)®

-

=+

M

----- % RSF524UEAXFE (Microcontroller)

ode Generator (Design Tool)

)'* Pin View
Elﬁ Peripheral Functions

----- i? Clock Generator
- W' Voltage Detection Circuit

- W Multi-Function Timer Pulse Unit 3
..... W' Port Qutput Enable 3
" General PWM Timer
-7 8-Bit Timer
- Compare Match Timer
..... W' Independent Watchdog Timer
7@ Serial Communications Interface
..... W' 12C Bus Interface
..... W' Serial Peripheral Interface
..... W' CRC Calculator
7@ 12-Bit A/D Converter
..... W D/A Converter
- W' Comparator C

..... &' Data Operation Circuit

G-uo Code Preview

Figure 4-17 Select I/O Ports
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RSKRX24U 4. Code Generation Using the CS+ plug in

4.4.6 /0 Ports

Referring to the RSK schematic, LEDO is connected to P21, LED1 is connected to P22, LED2 is connected to
PC3 and LEDS3 is connected to PC4. Navigate to the ‘I/O Ports’ tab in Code Generator and configure these
four I/O lines as shown in Figure 4-18 and Figure 4-19 below. Ensure that the ‘Output 1’ tick box is checked.
This ensures that the code is generated to set LEDs initially off.

i PropgrtyLEH Peripheral Functions®

] Generate Code | % (1 &8 (& @ B & B DB DD DT HE T E L MG

Portd | Port1 Port3 | Port4 | Ports | Ports | Port7 | Ports | Porta | PortA | PortB | PortC | PortD | PertE | PortF | PortG |

- F20

@ Unused @ nr T Out ¥ Pull-up CMOS output Output 1 High-drive output
- P21

@ Unused @ In Pull-up CMOS output - [ High-drive output
-F22

) Unused @ In Pull-up CMOS output - [ High-drive output
-F23

@ Unused I @ Out Pull-up CMOS output Output 1 High-drive output
- P24

@ Unused I ) Out Pull-up CMOS output Output 1 High-drive output
-F25

@ Unused 1 In ) Ot Pull-up CMOS output Output 1 High-drive: output
- P26

@ Unused @ In ) Out Pull-up CMOS output Output 1 High-drive output
-F27

@ Unused & In @ Out Pull-up CMOS output Output 1 High-drive output

Figure 4-18 1/0O ports — Port2

F% Property |};g Peripheral Functions™
—

T] GenerateCode | % J &8 [ #° W 5 3 D 0 DD & A S Gl doM B
| Fortd | Port1 | Pori2 | Fert3 | Fort | Port5 | Ports | Fort7 | Fortg | Port | For | ForiB FortD | FortE | FortF | FontG |

- PCO

@ Unused © In ) Out Pull-up CMOS output Output 1 High-drive output
-PC1

@ Unused @ In © Out Pull-up CMOS output Output 1 ks ey
- PC2

@ Unused @ In ) Out Pull-up CMOS output Qutput 1 High-drive output
-PC3

) Unused @ In Pull-up CMOS output - [ High-drive output
_PCs

© Uwsed O Pulup  CMOS output - [] High-drive output
-PC5

@ Unused ©In ) Out Pull-up CMOS output Output 1 High-drive output
-PC6

@ Unused @ In ) Out Pull-up CMOS output Output 1 High-drive output

Figure 4-19 1/0O ports — PortC
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4. Code Generation Using the CS+ plug in

P27 is used as one of the LCD control lines, together with P34, P55 and P65. Configure these lines as shown
in Figure 4-20, Figure 4-21, Figure 4-22 and Figure 4-23.

P.-m|ﬂ Peripheral Functions™ |

'@j Generate Code

e

B W assd DT T DS

Portd | Port1 || Port2 | Port3 | Port4 | Port5 | Porte | Port7 | Port8 | Ports | Porta | Port | PortC | PortD | Porte | PortF | PortG |

Figure 4-20 1/0O ports — Port2

- P20

@ Unused ®hn @ & ouw @ [ Pulup |CMDS output v| [ Cutput 1 [] High-drive output
- P21

) Unused I @ Out [ Pullup CMOS output - Output 1 High-drive output
- P22

) Unused =) In @ Out [ Pullup CMOS output - Output 1 High-drive output
-P23

@ Unused I in () Out [ Pullup |CMDS output v| [ Output 1 [] High-drive output
P24

@ Unused ' ln @ Out [ Pullup |CMDS output v| [ output 1 [] High-drive output
- P25

@ Unused ' n () Out [ Pullup |CMDS output v| [ Output 1 [] High-drive output
P26

@ Unused ) In ©) Out [ Pullup |CMDSoutput .| [] Output 1 [] High-drive output
-F27

) Unused © In [ Pull-up CMOS output - High-drive output

P;m|ﬂ Peripheral Functions®

%l Generate Code

SLUSEFBEDODDL T TIE G M

| Portd | Port1 | Pori2 | Port2 N Pori | Port5 | Ports | Pert7 | Portg | Portd | Porta | Perte | PortC | PortD | PoriE | PoriF | PortG |

Figure 4-21 1/O ports — Port3

P30

@ Unused © In ) Out [ Pullup |CMDSoutput v| [ Output 1 [] High-drive output
- P31

@ Unused ) In ) Out [ Pullup |CMDSoutput v| [ Output 1 [] High-drive output
-P32

@ Unused ) In ) Out [ Pullup |CMDSoutput v| [ Output 1 [] High-drive output
-P33

@ Unused ) In ©) Out ] Pullup |CMDSoutput v| [] Output 1 [~ ISk v o
-P34

© Unsed O [JFulup  CMOS output - High-dive output
- P35

@ Unused 1 n ) Out [ Pullup |CMDSoutput v| [ Output 1 [] High-drive output
- P36

@ Unused )in ® © 0w ® [JPulip  [CMOSoutput +| O output 1
_pa7

@ Unused Dt D) Ot Y [ Pullup |CMDSoutput v| [ Output 1

R20UT3761EG0100 Rev. 1.00
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4. Code Generation Using the CS+ plug in

ﬂ Peripheral Functions™

'ﬁ.‘jﬁenerateﬂude _-"-_,|;| ﬁ&'{i{#;ﬁ;ﬁ@aﬁﬁﬁfﬁfm%#\ﬂﬂj@
|Pu-tﬂ|Pu-ﬂ|Pu-tZ|Puﬂ|Pu-t-iPmﬁle?lPuﬂlPuﬂﬂlPuﬂleBlecleDlmelPu-tFlF-‘u-tG|
- P50
@ Unused ® In & Out [] Pull-up [] Output 1
- P&
@ Unused @ In & Out ] Pullup [ Output 1
- P52
@ Unused & In i Out ] Pull-up [] Output 1
- Ph3
@ Unused & In i Out ] Pull-up [ Output 1
- Phd
@ Unused @ In i Out ] Pullup [ Output 1
- PhS
O Unussd O n [ Pullup

Figure 4-22 1/0O ports — Port5

ﬂ F'eripherﬂl Functions™ I—

Figure 4-23 1/O ports — Port6

%] GenerateCode | % [ o [ #° W o5 S0 ) 00 @) &) @ J off JF U0 G W2
|Pu.—tﬂ|Pm1|sz|Pma|Pm4|Puﬁlmipm?|mﬂ|mﬂ|m|ms|Pu1c|PmD|PmE|PmF|PmG|
@ Unused ®In % & Ot @ [ ]Pulup (] Output 1
- P&1
@ Unused & In i Out ] Pull-up (] Output 1
- P62
@ Unused @ In & Out [1 Pull-up (] Output 1
- P63
@ Unused & In i Out ] Pull-up (] Output 1
- P64
@ Unused @ In & Out [1 Pull-up (] Output 1
- P65
) Unused @ In ] Pull-up Output 1
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4. Code Generation Using the CS+ plug in

Peripheral function configuration is now complete. Save the project using the File -> Save Project menu item,
then click ‘%l Generate Code’. The Output pane should report ‘The operation of generating file was

successful’, as shown Figure 4-24 below.

Output

Start generate code (2016/12/21 11:57:28)
¥0403002:The generating source folder is: C:\Workspace\CG Tutoriall,]
M0403001:The following files were generated:]
M0403000:cg_srohr_cg main.c was generated.
M0403000-cg_src\r_cg_dbsct_c was generated .|
M0403000:cg_szrohr_cg_intprg.c was generated.,|
M0403000-cg_src\r_cg_resetprg.c was generated.|
M0403000:cg_szrohr_cg sbrk.c was generated.
M0403000-cg_src\r_cg_wecttbl c was generated
M0403000:eg_src\r_cg sbrk.h was generated.|
M0403000-cg_srch\r_cg_stacksct_h was generated.|
M0409000-eg_sro\r_cg_weet h was generated |
M0403000:cg_srohr_cg hardware setup.c was generated.,|
M0403000-cg_src\r_cg_macrodriver h was generzted |
M0403000:eg_sro\r_cg userdefine.h was generated.
M0403000-cg_sro\r_cg_cge.c was generated.,|
M0403000:cg_srohr_cg_cge_user.c wes generated.|
M0403000-cg_src\r_cg_cge.h was generated.,|
M0405000:cg_srohr_cg icu.c was generated.,|
M0403000-cg_src\r_cg_icu_user c was generated.|
M0403000:eg_sro\r_cg icu.h was generated.
M0403000-cg_src\r_cg_port c was generated |
M0403000:cg_srohr_cg pert_user.c was generated.
M0403000-cg_src\r_cg_port h was generated. |
M0405000°cg_sro\r_cg_cmt.c was generated |
M0403000:cg_srohr_cg cmt_user.c wes generated.|
M0403000:eg_sre\r_eg_cmt h was generated.
M0403000:cg_srohr_cg sci.c was generated.,|
M0403000-cg_src\r_cg_sci_user_c was generated |
M0405000:cg_srohr_cg sci.h was generated.,|
M0403000-cg_src\r_cg_slZad.c was generated.,|
M0403000:eg_sro\r_cg slZad user.c was generated.
M0403000:eg_sre\r_cg_slZad.h was generated.

¥0403003:The cperation of generating file was successful.]
Cenerate code ended (2016/12/21 11:57:23)

m

'\ All Messages | Code Generater | *Repid Bulld |

Figure 4-24 Code generator console

Figure 4-25 shows the Code Generator Files in the Project Tree pane. In the next section the CG_Tutorial
project will be completed by adding user code into these files and adding new source files to the project.

Project Tree

2 03 @

[X]

- ﬁcs Tutorial (Project
R5F524UEAXFB (Microcontroller)

Code Generator (Design Tool)

A, CC-RX (Build Tool)

22 RX Simulator (Debug Tool)

File

'[m Build tocl generated files

& : Code Generator

----- ‘d r_cg_main.c

----- ‘d r_cg_dbsct.c

----- ‘d r_cg_intprg.c

----- ‘d r_cg_resetprg.c

----- ‘d r_cg_shrk.c

..... (d r_cg_port.c

----- ‘d r_cg_port_user.c
..... & rcg_cmt.c

..... (d r_cg_cmt_user.c
..... & r_cg_scic

..... td I_CQ_SCi_user.c
..... ‘d r_cg_slZad.c

..... td r_cg_sl2ad_user.c
..... u r_cg_sbrk.h

Figure 4-25 Code Generator Files in the Project Tree
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5. Completing the Tutorial Project

5. Completing the Tutorial Project

5.1 Project Settings

Property |£ Peripheral Functions®

e In the ‘Project Tree' pane, select

=

A, CCX Propetty

4 Build Mode
Build mode

‘CC-RX (Build Tooly. The build
properties will appear in the main
window.

e C(CS+ creates a single build
configuration called ‘Default Build’
for the project. This has standard
code optimisation turned on by
default.

4 CPU
Instruction set architecture
Uses floating-point operation instructions
Endizn type for data

Replaces the int type with the short type
Sign of the char type
Sign of the bitfield type

Order of bit-field members

Branch width size
Base register for ROM
Base register for RAM

Auvoids a problem specific to the CPU type

PIC/PID

Output File Type and Path

Output file type

Intermediate file output folder
Frequently Used Options(for Compile)
Additional include paths

System include paths

Macro definition

Outputs debugging information
Optimization level

S

vV v e

Change property value for all build modes at once

Selects the enumeration type size sutomatically

Rounding method for floating-paint constant cperations
Handling of denormalized numbers in flosting-peint constants
Precision of the double type and long double type

Saves and restores ACC using the interrupt function

Assumes the boundary alignment value for structure members s 1
Enables C++ exceptional handling function (try, catch and throw)

Address value of bse register that scts the address value
Register of base register that sefs the address value

Enables the C++ exceptional handling function (dynamic_castand typeid)
General registers used arly in fast interrupt functions

Default Build

o

RXv2 architecturetisa=ov2)

Yes(fpu)

Litle-endian datal-endianitile)

round to nearest{ound=nearest)
Handles as zeros{-denomalize=cff}
Handles in single precision{-dbi_size=4)
No

Handles as unsigned char(unsigned_char)
Handles as unsignediunsigned_bitfield)
No

Allocates from righttbit_order=right)
Nofunpack)

No{noexception)

Nottti=off)

Nore(fint_register=0)

Compiles within 24 bits(branch=24)
Nore

None

(=] 00000000
None

No

No

Execute Module(Load Module File)
%BuildModeName %

Additional include paths[1]
System include paths0]

Macro definiton[0]

Yes(debug)

2(optimize=2)

"\ CC-RX Property
4 Source

e Select the ‘Compile Options’ tab at
the bottom of the properties window

pane. Under ‘Language of the C Langmge ofthe Ce+ source e
. , " , [> 1monal include paths
source file’ select ‘C99(-lang=c99) > System include paths
H > Include files at the head of compiling units
as Shown OppOSIte' > Macro definition

Invalidates the predefined macro

Enables information-level message output

Language of the C source file C(C83)Hang=c)

29){Jang=
C95ang-c99)
FSIENTITCIIUE ParTS[o]
Include files at the head of compiling units[0]
Macro definition[0]

No(-nomessage)

Suppresses the number of information-level messages

Changes the warning-level messages to information-level messages No

Changes the information-level m ges to warning-level m No
|

Changes the information-lev I to error-level messa No

| and warning-level m

Permits comment (i* /) nesting

Nol(-comment=nonest)

e Select the ‘Link Options’ tab at the || Sumeew Ko cp 0O e
bOttom Of the prOpertieS WindOW ‘ mstarladdress 8_1,R_1.8_2.R_2,8.R.5U.5I/04 PResetPRG/OFFFB0000.C_1C_2,C CSDSEC,CSBSEC.CSINIT
. . » The specified section that outputs externally defined symbols to the file The specified section that outputs extemally defined symbols to the file[0]
pane. Under ‘Section -> ROM to | | sccome E
RAM mapped section’, add the three | |:
mappings as shown opposite.
e These settings are easily added by Text Edit =
clicking the button ‘... and pasting Text:
the following text into the dialog: — -
O_1=R_1
D 2-R 2|
D=R
D_1=R_1
D 2=R 2
e This ensures that the linker assigns
RAM rather than ROM addresses to
C variables. Click ‘OK’
4 ¥
oK | [ cancel |[ hep
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e From the ‘Build’ menu, select ‘Build
Mode Settings...”. Click ‘Duplicate’
and in the resulting ‘Character String
Input’ dialog, enter ‘Debug’ for the
name of the duplicate Build Mode.

CG_Tutorial - C5+ for CC - [Project Tree]

X Ba @] 09 o ||Ed Build Project F7
@ Rebuild Project Shift=F7
@ Clean Project

File Edit View Project Debug Tool Window Help

Rapid Build
5 Update Dependencies
J Code Generatq | . .
d‘ CC-RX (Build T 1"_] Build CG_Tutorial
25 RX Simulator (| ig] Rebuild CG_Tuterial
j File A} Clean CG_Tutorial
- F Build tool ¢ ° i ]
B[E Code Gend 3{ Update Dependencies of CG_Tutorial
..... €| r_cg_m| = SetLink Order of CG_Tutorial..
""" ‘d rcg_dk #1| Open the Optimization Performance Comparison Teol for CG_Tutorial...
..... & r_cg_in
_____ :ﬂ r_cg_re e Stop Build Ctrl+F7
""" ‘-:j "c9-*8T; Build Mode Settings...
..... & r_cgv -
_____ ‘d r_cg_ha 1:_1 Batch Build...
----- & rcgcg Ty Build Option List
I
Build Mode Settings =3
Selected build mode:
l Apply to Al
Build mode list:
PR
[ Close J l Help
e The new ‘Debug’ Build Mode will be P’“”‘“’ e Pt = 52[
. . . CCRY Fropery
added to the Build Mode list. Click | |- e N
. . Build mode DefaulBuid
‘C|Ose’. NOW, in the main CC_RX (C:hpaungepmpem/va\uefara\\build modes atonce
Property  window, under the A

‘Common Options’ tab, click on the
line containing ‘Build Mode’, click the
pull-down arrow and select ‘Debug’
from the pull-down’.

e In the ‘Frequently Used Options (for

Compile)’  group, select  the
‘Optimization Level’ option and
select ‘0’ from the pull-down. We

have now created a ‘Debug’ Build
Mode with no code optimisation and
will be using the Build Mode to
create and debug the project.

Property |¢%| Peripheral Functions
=

4, CCRX Propetty

Build Mode

cPU

PIC/PID
Output File Type andPath
Frequently Used Options(for Compile)
Additional include paths
System include paths

Macro definition

Outputs debugging information

Additional include paths]1]
System include paths[0]

Macro defirition[0]

Yes
2

vevhvww

Outputs additional information for inter-medule optimization
Optimization type
Outputs a source st file

Ol-otimize=0)
1{-optimize=1)
2(-optimize=2)

8

Frequently Used Options(for Assemble) Mazxl-optimize =max)
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e All of the sample code projects
contained in this RSK are configured
with three Build Modes;
‘DefaultBuild’, ‘Debug’ and ‘Release’.
‘Release’ is created in the same way
as above; by duplicating ‘Default
Build’. ‘Release’ Build Mode leaves
code optimisation turned on and
removes debug information from the
output file.

e To remove debug information from
the ‘Release’ Build Mode, in the ‘CC-
RX Property’ window, select the
‘Common Options’ tab at the bottom
of the window pane. For the
‘Outputs  debugging information’
option, select ‘No(-nodebug).

e Reset the Build Mode back to
‘Debug’ using the ‘Build Mode’ pull-
down control.

e From the menus, select ‘File -> Save
All' to save all project settings.

Property |¢%| Peripheral Functions
=

=]

4, CCRX Fropetty
4 Build Mode

Build mode

Change property value for all build modes at once
> CPU

(& (& [

Additional include paths[1]
System include paths[0)
ition|

(3]

.2 Additional Folders

e Before new source files are added
to the project, we will create two
additional folders in the CS+
Project Tree.

e In the Project Tree pane, right-click
the CG_Tutorial project and select
‘Add -> Add New Category’.

e Rename the newly-created ‘New
Category’ folder to ‘C Source Files’.
Repeat these steps to create a new
category folder for ‘Dependencies’.

Project Tree 4 X
¢ @ 2|3
=8N CG Tutorial (Pas
H R5F524UEA‘E] Build CG_Tutorial
| Code Gene ] Rebuild CG_Tutorial
CC-BX(BU & Clean CG_Tutorial
=, RX Simulat
=] j!l File i"_.{ Open Folder with Explorer
) Build tq [ Windows Explorer M
: plorer Menu
- ) Code
Add Yl [F Add Subproject...
tf3 Set CG_Tutorial as Active Project |+}§ Add Mew Subproject...
Save Project and Development Tools as Package... ._l Add File...
@ Paste Chrl+V ] Add New File...
@@ Rename F2 m Add New Category
Project Tree o x
A
: © 2|

=T CG Tutorial (Project)*
- {E RSF524UEAxFB (Microcontroller)

. Ay, CC-RX (Build Tool)

------ 2 R Simulator (Debug Tool)

= File

- ﬂ Build tool generated files

_,J Code Generator (Design Tool)
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5.3 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Locate the files ascii.h, r_okaya_lcd.h, iodefine.h,
ascii.c, and r_okaya_lcd.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder.

¢ Right-click on the ‘C Source Files’
in the Project Tree and select ‘Add -

=3 File
- ﬂ Build tool generated files
_1 Code Generator

> Add File...". O e — —
i || Dependenci 'LJ' Add File..
Bl OpenF ] Add New File...
El| Windows Explorer Menu 1) Add New Category
E_‘ Remaove from Project Shift+Del
dy Copy Ctrl+C
[ Paste Ctrl+V
#@ Rename F2
5 Property
e Browse to the files ascii.c, and €3 Add Exsting File ==
r_0kaya_|CdC in . the QQ | .« Workspace » CG_Tutorial » v|¢'v,|| Search CG_Tutonial Pl
C:\Workspace\CG_Tutorial folder -
H ‘ ’ 0 - Mew fold g== = (7]
and click ‘Open’. g e o il
- F . Name
[ Favorites
| €g_src
= Libraries ) Debug
. DefaultBuild
1% Computer J Release
|| ascii.c
&i Metwork | r_okaya_lcd.c
q i r
File name: "r_ckaya_lcd.c" "ascii.c” - [Csourcefile(*.c] v]
[ Dpen ] ’ Cancel ]
e Repeat the above steps to add the €3 Add Existing File ==
ﬂles‘ ascii.h anq r’_okaya_lcd.h to QQ [0l <« Workspace » CG_Tutorial » « %9 ||| Search €6 Tutoria ol
the ‘Dependencies’ folder. -
. . Organize v New folder =~ O @
Note: Choose ‘Header file (*.h; *.hpp; =
* g ’ i i [ Favorites Bame
.inc) from file list. |
| €g_src
= Libraries ) Debug
DefaultBuild
1% Computer ) Release
€ Network iodefine.h
q | 1 b
File name: "r_okaya_lcd.h" "asciih” + B Header file (".h; ".hpp; *.inc) -
Open Cancel
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e Repeat the above steps to add the =L File
file iodefine.h to the ‘File’ folder. f]], Build tool generated files

[+-|_|) Code Generator

=L ) Dependencies

----- U ascit.h

(. u r_ockaya_lcd.h
..... b-| iodefine.h

Code must be inserted in to the user code area in many files in this project, in the areas delimited by
comments as follows:

/* Start user code for _xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Code Generator, if the user needs to subsequently change any of the Code Generator-generated code.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file r_cg_userdefine.h’ by double-

clicking on it. Insert the following #defines in between the user code delimiter comments as shown below.
/* Start user code for function. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the CS+ Project Tree, open the file ‘r_cg_main.c’ by double-clicking on it. Insert #include "r_okaya_lcd.h" in

between the user code delimiter comments as shown below.
/* Start user code for include. Do not edit comment generated here */

#include "r okaya lcd.h"

/* End user code. Do not edit comment generated here */

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
user code area of the ‘main’ function:

void main (void)
{
R_MAIN UserInit();
/* Start user code. Do not edit comment generated here */

/* Initialize the debug LCD */
R LCD_Init();

/* Displays the application name on the debug LCD */
R LCD Display (0, (uint8 t *)" RSKRX24U ");

R LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display(2, (uint8 t *)" Press Any Switch ");
while (10U)

{

}

/* End user code. Do not edit comment generated here */
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5.3.1 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Code Generator in §4.4.5. In
the CS+ Project Tree, open the file r_cg_sci.h’ by double-clicking on it. Insert the following code in the user

code area at the end of the file:
/* Start user code for function. Do not edit comment generated here */

MD STATUS R SCI9 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */

Now, open the r_cg_sci_user.c file and insert the following code in the user area for global:
/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t sci9 txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI9:
void r sci9 callback transmitend(void)
{

/* Start user code. Do not edit comment generated here */
sci9 txdone = TRUE;

/* End user code. Do not edit comment generated here */

Now insert the following function in the user code area at the end of the file:
/* Start user code for adding. Do not edit comment generated here */

KKk ok ok ok ok kKA A A K Kk ok ko k ok ok ok kA A A A A KKk ko k ok ok ok kR A A A A A K Kk ko k ok ok ok kA A A A K Kk Kk kR ok ok ok ok ok

* Function Name: R SCI9 SPIMasterTransmit

* Description : This function sends SPI9 data to slave device.
* Arguments ¢ tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

***********************I*******************************************************/
MD STATUS R_SCI9 SPIMasterTransmit (uint8 t * const tx buf, const uintlé6_t tx num)

{
MD STATUS status = MD OK;

/* Clear the flag before initiating a new transmission */
sci9 txdone = FALSE;

/* Send the data using the API */
status = R SCI9 SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == sci9 txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R _SCI9 SPIMasterTransmit

KA KK KKK KKK K K KK K K R K K K K R K R K K K R R K K R R R K K R R R R K R R ok kR R R R kR kR R Rk Rk R R Rk ok kK /

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD, and is used as the main API call in the LCD code module.
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5.3.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Code Generator in §4.4.3. Open the file r_cg _cmth
and insert the following code in the user area for function at the end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file r_cg_cmt_user.c and insert the following code in the user area for global at the beginning of the
file:
/* Start user code for global. Do not edit comment generated here */

static volatile uint8 t one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_cmt_cmiO_interrupt function and insert the following line in the user code area:
static void r cmt cmiO interrupt (void)
{

/* Start user code. Do not edit comment generated here */
one_ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:
/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
*******************************************************************************/
void R _CMT MsDelay (const uintl6_t millisec)

{

uintlé_t ms_count = 0;

do
{
R _CMTO_Start();
while (FALSE == one ms_delay complete)
{
/* Wait */
}
R_CMTO_sStop();
one_ms_delay complete = FALSE;
ms_count++;
} while (ms_count < millisec);

}

/*******************************************************************************

End of function R CMT MsDelay

KK KK KK KK K K K K K K R kK R Kk K R R R K R R R kK R Rk ok K R R R kR R R R Rk R R R Rk R ok R R R Rk ok ok /

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The program will display ‘RSKRX24U
Tutorial Press Any Switch’ on 3 lines in the LCD display.
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54 Switch Code Integration

API functions for user switch control are provided with the RSK. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Locate the files rskrx24udef.h, r_rsk_switch.h and
r_rsk_switch.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these three
files into the project in the same way as the LCD files.

The switch code uses interrupt code in the files r_cg_icu.h, r_cg_icu.c and r_cg_icu_user.c and timer code in
the files r_cg_cmt.h, r_cg_cmt.c and r_cg_cmt_user.c, as described in §4.4.2 and §4.4.3. It is necessary to
provide additional user code in these files to implement the switch press/release detection and de-bouncing
required by the API functions in r_rsk_switch.c.

5.4.1 Interrupt Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_icu.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */
uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no);

void R ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);
void R ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */

Now, open the r_cg_icu.c file and insert the following code in the user code area at the end of the file:
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/* Start user code for adding. Do not edit comment generated here */

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R ICU IRQIsFallingEdge

* Description : This function returns 1 if the specified ICU IRQ is set to

* falling edge triggered, otherwise 0.

* Arguments : uint8 t irg no

* Return Value : 1 if falling edge triggered, 0 if not
*******************************************************************************/

uint8 t R ICU IRQIsFallingEdge (const uint8 t irg no)

{ uint8 t falling edge trig = 0x0;
if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE FALLING)
{ falling edge trig = 1;
}

return (falling edge trig);

VAREEEEEEE SRR EEE AR R Rt EEE Rt EE Rt

* End of function R _ICU IRQIsFallingEdge

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***********************/

VAREEEEEEE RS EEEE LR R Rt EEE Rt EE Rt

* Function Name: R ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
*******************************************************************************/

void R ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{
if (1 == set_f edge)
{
ICU.IRQCR[irg no] .BYTE |= 04 ICU IRQ EDGE FALLING;
}

else

{
ICU.IRQCR[irg nol] .BYTE &= (uint8 t) ~ 04 ICU IRQ EDGE FALLING;

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function R ICU IRQSetFallingEdge

LR EEEEE RS EEEE SRR R R EEE R R Rt

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R_ICU_ IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/

void R_ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge)
{
if (1 == set r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;

}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;

VAR AR EEE RS SRR R Rt EEE R R R RS R R

* End of function R ICU IRQSetRisingEdge

LR R EEE RS AR EEE R EE AR EE Rt EE Rt

/* End user code. Do not edit comment generated here */
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Open the r_cg_icu_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irq0_interrupt:
/* Start user code. Do not edit comment generated here */

/* Switch 1 callback handler */
R_SWITCH IsrCallbackl ()

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_icu_irq4_interrupt:

/* Start user code. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */

5.4.2 De-bounce Timer Code

Open the r_cg_cmt_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */
In the same file insert the following code in the user code area inside the function r_cmt_cmi1_interrupt:

/* Start user code. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R_CMT1_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_ DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function r_cmt_cmi2_interrupt:

/* Start user code. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R _CMT2_Stop();

/* Call the de-bounce call back routine */
R_SWITCH_ DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */
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543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In §4.4.4, we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file r_cg_userdefine.h’ by double-

clicking on it. Insert the following code the user code area, resulting in the code shown below
/* Start user code for function. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

extern volatile uint8_t g_adc_trigger;

/* End user code. Do not edit comment generated here */

Open the file r_cg_main.c’ and insert #include "r_rsk_switch.h" in the user code area for include, resulting in

the code shown below:
/* Start user code for include. Do not edit comment generated here */

#include "r okaya lcd.h"
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

Next add the switch module initialization function call highlighted in the user code area inside the main
function, resulting in the code shown below:
void main (void)
{
R MAIN UserInit();
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH TInit();

/* Initialize the debug LCD */
R LCD Tnit();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)'" RSKRX24U ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display (2, (uint8 t *)" Press Any Switch ");

while (10U)
{
}

/* End user code. Do not edit comment generated here */

}

In the same file, insert the declarations in the user code area for global, resulting in the code shown below:
/* Start user code for global. Do not edit comment generated here */

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* End user code. Do not edit comment generated here */
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Next add the highlighted code below in the user code area inside the main function and the code inside the
while loop, resulting in the code shown below:

void main (void)

{

R_MAIN UserInit();
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R _SWITCH Tnit();

/* Set the call back function when SW1l or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R _LCD Init ();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)'" RSKRX24U ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display (2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD0_Start();

while (10)
{

uintlé_t adc result;

/* Wait for user requested A/D conversion flag to be set
if (TRUE == g_adc_trigger)
{
/* Call the function to perform an A/D conversion */
adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_trigger = FALSE;
}

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R _S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_complete = FALSE;

}

else

{
/* do nothing */

}

}

/* End user code. Do not edit comment generated here */

(SW1 or SW2)

2/

Then add the definition for the switch call-back, get_adc and Icd_display_adc functions in the user code area
for adding at the end of the file, as shown below:
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/* Start user code for adding. Do not edit comment generated here */

VAR AR EEE RS e EEE RS E R Rt EE R R R Rt

* Function Name : cb switch press

* Description : Switch press callback function. Sets g_adc trigger flag.
* Argument : none

* Return value : none

******************************************************************************/

static void cb_switch press (void)

{

}

/* Check if switch 1 or 2 was pressed */

if (g _switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))

{
/* Set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;
}

/*****************‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* End of function cb switch press
******************************************************************************/

/******************************************************************************

*
*
*
*
*

Function Name : get adc

Description : Reads the ADC result, converts it to a string and displays
it on the LCD panel.

Argument : none

Return value : uintl6é t adc value

KK KKK KKK KKK KKK KKK KKK KKK KKK KKK KKK A KKK KKK KAXXXX KKK KA A KKK KKK XXXX KKK KAk khhkhx A xx [

static uintl6 t get adc (void)

{

}

/* A variable to retrieve the adc result */
uintlé t adc result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R S12AD0 Stop();

/* Start a conversion */
R_S12AD0_SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc complete)
{
/* Wait */
}

/* Stop conversion */
R_S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R _S12AD0 Get ValueResult (ADCHANNELO, &adc result);
/* Set AD conversion start trigger source back to ADTRGOn pin */

R_S12AD0O_Start();

return (adc_result);

/******************************************************************************

* End of function get adc
*******************‘k*‘k*‘k‘k***‘k*‘k‘k‘k‘k*‘k‘k‘k*‘k*‘k‘k*‘k*‘k*‘k*‘k‘k*‘k************************/
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/‘k‘k‘k‘k‘k‘k************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

~k~k****************************************************************************/

static void lcd display adc (const uintlé_t adc_result)
{

/* Declare a temporary variable */
uint8 t a;

/* Declare temporary character string */
char lcd buffer[11l] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (uint8_t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (uint8 t) ((adc_result & 0x00FO0) >> 4);

lcd buffer[7] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (uint8_t) (adc_result & 0xO000F);

lcd buffer[8] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Display the contents of the local string lcd buffer */
R_LCD Display(3, (uint8 t *)lcd buffer);

}

/******************************************************************************

* End of function lcd display adc

******************************************************************************/

Open the file ‘r_cg_s12ad.h’ by double-clicking on it. Insert the following code in the user code area for

function, resulting in the code shown below:
/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R S12AD0 SWTriggerStart (void);
void R S12AD0 SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */

Open the file r_cg_s12ad.c’ by double-clicking on it. Insert the following code in the user code area for

adding at the end of the file, resulting in the code shown below:
/* Start user code for adding. Do not edit comment generated here */

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R_S12AD0_SWTriggerStart
* Description : This function starts the AD converter.
* Arguments : None
* Return Value : None
*******************************************************************************/
void R_S12AD0_SWTriggerStart (void)
{

IR(S12AD, S12ADI) = 0U;

IEN (S12AD, S12ADI) = 1U;

S12AD.ADCSR.BIT.ADST = 1U;
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

End of function R S12AD0_SWTriggerStart

*******************************************************************************/
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/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStop

* Description : This function stops the AD converter.

* Arguments : None

* Return Value : None
*******************************************************************************/

void R S12AD0 SWTriggerStop (void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN (S12AD, S12ADI) = 0U;
IR(S12AD, S12ADI) = 0U;

}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***************************

End of function R S12AD0 SWTriggerStop

LR EEE R SRR R EE Rt R R R R EEEE Rt EREEE Rt R R R Tt

/* End user code. Do not edit comment generated here */

Open the file r_cg_s12ad_user.c and insert the following code in the user code area for global, resulting in the

code shown below:
/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc_complete;

/* End user code. Do not edit comment generated here */

Insert the following code in the user code area of the r_s12ad0 _interrupt function, resulting in the code shown
below:

static void r sl12ad0_interrupt (void)
{
/* Start user code. Do not edit comment generated here */

g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the ADPOT line and display the result on the
LCD panel. Return to this point in the CG_Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK serial port are provided with the RSK. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Locate the files r_rsk_debug.h and
r_rsk_debug.c in this folder. Copy these files into the C:\Workspace\CG_Tutorial folder. Import these two files
into the project in the same way as the LCD files.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL DEBUG WRITE (R _SCI1 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration
5.6.1 SCI Code

In the CS+ Project Tree, expand the ‘Code Generator’ folder and open the file ‘r_cg_sci.h’ by double-clicking
on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R _SCI9 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);
MD STATUS R _SCI1 AsyncTransmit (uint8 t * const tx buf, const uintlé t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* Flag used to control transmission to PC terminal */
extern volatile uint8 t g tx flag;

/* End user code. Do not edit comment generated here */

Open the file r_cg_sci_user.c. Insert the following code in the user area for global near the beginning of the
file:
/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g rx char;

/* Flag used to control transmission to PC terminal */
volatile uint8_t g_tx flag = FALSE;

/* Flag used locally to detect transmission complete */
static volatile uint8 t sci9 txdone;
static volatile uint8 t scil txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the r_sci1_callback_transmitend

function:
void r scil callback transmitend(void)

{
/* Start user code. Do not edit comment generated here */

scil txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area inside the r_sci1_callback receiveend

function:
void r_scil_callback_receiveend(void)

{

/* Start user code. Do not edit comment generated here */

/* Check the contents of g rx char */
if (('c' == g_rx char) || ('C' == g_rx_char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI1 receive buffer and callback function again */
R _SCI1 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/‘k‘k‘k‘k‘k‘k*************************************************************************

* Function Name: R SCI1 AsyncTransmit

* Description : This function sends SCI1 data and waits for the transmit end flag.
* Arguments ¢ tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD ARGERROR

***********************:*******************************************************/
MD_STATUS R_SCI1_ AsyncTransmit (uint8 t * const tx_buf, const uintl6_t tx_ num)

{
MD_STATUS status = MD_OK;

/* clear the flag before initiating a new transmission */
scil txdone = FALSE;

/* Send the data using the API */
status = R_SCI1 Serial Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == scil_ txdone)
{
/* Wait */
}
return (status);

}

KRR KK K K K K K KK K K R K R K R K K K R R K K R K R o K R R R o K R R R kK K R R kK R Rk Rk Rk Rk kK

* End of function R SCI1 AsyncTransmit
*******************************************************************************/
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5.6.2 Main UART code

Open the file r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:
/* Start user code for include. Do not edit comment generated here */

#include "r okaya lcd.h"
#include "r rsk switch.h"
#include "r rsk debug.h"

/* End user code. Do not edit comment generated here */

Add the following declaration to the user code area for global near the top of the file:
/* Start user code for global. Do not edit comment generated here */

/* Variable for flagging user requested ADC conversion */

volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintlé_t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6é t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8 t adc count = 0;

/* End user code. Do not edit comment generated here */

Add the following highlighted code to the user code area in the main function:
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void main (void)

{

R MAIN UserInit();
/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */

R SWITCH Init();

/* Set the call back function when SWl or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */

R _LCD Init();

/* Displays the
R_LCD Display (0,
R_LCD Display(1l,
R_LCD Display(2,

/* Start the A/D

R _S12AD0_Start ()

application name on the debug LCD */
(uint8 t *)" RSKRX24U ");
(uint8_t *)" Tutorial ");
(uint8 t *)" Press Any Switch ");

converter */

’

/* Set up SCI1 receive buffer and callback function */
R_SCI1_Serial Receive((uint8_t *)&g_rx char, 1);

/* Enable SCI1 operations */

R SCI1 Start();

while (10)
{

uintlé_t adc_result;

/* Wait for
if (TRUE ==
{

/* Call

user requested A/D conversion flag to be set
g_adc_trigger)

the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the adc_count */
if (16 == (++adc_count))

{

adc_count = 0;

}
/* Send

the result to the UART */

uart display adc(adc_count, adc result);
/* Reset the flag */
g _adc_trigger = FALSE;

}

/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)

{

/* Get the result of the A/D conversion */
R_S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the adc_count */
if (16 == (++adc_count))

{

adc_count = 0;

}
/* Send

the result to the UART */

uart display adc(adc_count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;

}

else

{

/* do nothing */

}
}

/* End user code. Do not edit comment generated here */

}

(SW1 or SW2)

*/
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Then, add the following function definition in the user code area at the end of the file:

VAR AR EEEEE RS SRR et EEE AR et

* Function Name : uart display adc
* Description : Converts adc result to a string and sends it to the UARTL.
* Argument : uint8 t : adc_count

*

uintlé t: adc result

* Return value : none
******************************************************************************/

static void uart display adc (const uint8 t adc_count, const uintlé t adc_ result)

{

}

/* Declare a temporary variable */
char a;

/* Declare temporary character string */
static char uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char) (adc_count & 0x000F);

uart buffer[4] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0x0F00) >> 8);

uart buffer[14] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) ((adc_result & 0x00FQ0) >> 4);

uart buffer[15] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));
a = (char) (adc_result & 0x000F);

uart buffer[16] = (char) ((a < 0x0A) ? (a + 0x30) : (a + 0x37));

/* Send the string to the UART */
R DEBUG Print (uart buffer);

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k****************************************************

* End of function uart display adc
*****************************************************‘k‘k***********************/

Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. Connect the RSK G1CUSBO port to a
USB port on a PC. If this is the first time the RSK has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will now appears under 'Port (COM &
LPT)' as 'RSK USB Serial Port (COMx)', where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI1 (see §4.4.5).
When any switch is pressed, or when ‘¢’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the ADPOT line and display the result on the LCD panel and send the result to the PC

terminal program via the SCI1. Return to this point in the CG_Tutorial to add the LED user code.
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5.7 LED Code Integration

Open the file r_cg_main.c’. Add the following declaration to the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

#include "r okaya lcd.h"

#include "r rsk switch.h"

#include "r rsk debug.h"

#include "rskrx24udef.h"

/* End user code. Do not edit comment generated here */

Add the following declaration to the user code area for global near the top of the file:
/* Start user code for global. Do not edit comment generated here */

/* Variable for flagging user requested ADC conversion */

volatile uint8 t g adc trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8_t adc_count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

/* End user code. Do not edit comment generated here */

Add the following highlighted code to the user code area in the main function:
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void main (void)

{

R MAIN UserInit();

/* Start user code. Do not edit comment generated here */

/* Initialize the switch module */
R_SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */

R_SWITCH_ SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R_LCD Init();

/* Displays the application name on the debug LCD */
R_LCD Display(0, (uint8 t *)'" RSKRX24U ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R _LCD Display (2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R_S12AD0O_Start();

/* Set up SCI1 receive buffer and callback function */
R_SCI1_Serial Receive((uint8_t *)&g_rx char, 1);

/* Enable SCI1 operations */
R_SCI1_Start();

while

{

}

{

}

/* SW3 is directly wired into the ADTRGOn pin so will

(10)

uintlé_t adc_ result;

/* Wait for user requested A/D conversion flag to be set
if

(TRUE == g adc_ trigger)

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */

if (16 == (++adc_count))
{
adc_count = 0;
}
led display count (adc_count) ;
/* Send the result to the UART */
uart display adc(adc_count, adc result);
/* Reset the flag */
g _adc_trigger = FALSE;

cause the interrupt to fire */

else if (TRUE == g adc complete)

{

}

/* Get the result of the A/D conversion */

R _S12AD0 Get ValueResult (ADCHANNELO, &adc result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the adc_count and display using the LEDs */

if (16 == (++adc_count))
{
adc_count = 0;
}
led display count (adc_count) ;

/* Send the result to the UART */

uart display adc(adc_count, adc result);
/* Reset the flag */

g_adc_complete = FALSE;

else

{

}

/* do nothing */

/* End user code. Do not edit comment generated here */

(SW1 or SW2) */
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Then, add the following function definition in the user code area at the end of the file:

KKk ok ok ok ok kK A A K K Kk ko ko k ok ok ok kA A AR A K Kk ko k ok ok ok kA A AR A K Kk ko k ok ok ok ok kA A A K K Kk ok ko k ok ok ok ok

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDSO0-3
* Argument : uint8 t count

* Return value : none

AR EEEE RS e EEEEEEEEEE e AR R Rt EE R

static void led display count (const uint8 t count)
{
/* Set LEDs according to lower nibble of count parameter */
LEDO = (uint8 t) ((count & 0x01) ? LED ON : LED OFF);
LEDl = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8 t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8_t) ((count & 0x08) 7 LED ON : LED OFF);
}

/******************************************************************************

* End of function led display count
******************************************************************************/

/* End user code. Do not edit comment generated here */
Select ‘Build Project’ from the ‘Build’ menu, or press F7. CS+ will build the project with no errors.

The project may now be run using the debugger as described in §6. The code will perform the same but now
the LEDs will display the adc_count in binary form.
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6. Debugging the Project

6.

Debugging the Project

e In the ‘Project Tree’ pane, right-click the | [EEEILE
‘RX Simulator (Debug Tool).  Select 8 @ alE
‘Using Debug Tool -> RX E2 Lite’. o[ 1 CG Tutorial (Project)”
i&, RSF524UEAXFE (Microcontreller)
Code Generator (Design Tool)
- Pin View
5 Peripheral Functions
-+ Code Preview
CC-RX (Build Teol)
File Using Debug Tool b” R E2 Lite
| Property RX E1(Serial)
RX E20(Serial)
RX Simulator
e Double-click ‘RX E2 Lite (Debug Tool) to | [ Property
display ‘ the ,debugger tool prppertles. S FXC2 Lo Propery
Under ‘Clock’, change the main clock = :
frequency to 20 MHz and operating s ernal ROMKBytes] 512
frequency to SOMHz.’ Size of internal RAM[KEytes] 32
. . Size of DataFlash memory[KEytes] 8
e Under ‘Connection with TargetBoard’, 4 Clock
‘ Main clock source EXTAL
Change Power targetfrom the Main clock frequency[MHz] 20.0000
emUIator'(MAX 200mA)t0 Yes Operating frequency[MHz] 80.0000
. . . Allow changing of the clock source on writing internal flash memaory Nao
e All other settings can remain at their || , connectionwith Enst
defaults. Emulator serial No.
4 Connection with Target Board
Power target from the emulator (MAX 200md) Yes
Supply voltage 3.3V
Communications method FINE
FINE baud rate[bps] 1500000
e Connect the E2 Lite to the PC and the
RSK E1/E2 Lite connector. Connect the
Pmod LCD to the PMOD1 connector.
e From the ‘Debug’ menu select ‘Download’

to start the debug session and download
code to the target.
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7. Running the Code Generator Tutorial

71 Running the Tutorial

Once the program has been downloaded onto the RSK device, the program can be executed.
Click the ‘Go’ button or press F5 to begin the program from the current program counter
position. It is recommended that you run through the program once first, and then continue to
the Tutorial manual to review the code.

®
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8. Additional Information

Technical Support
For details on how to use CS+, refer to the help

file by opening CS+, then selecting Help > Help Tool Window | Help|
Contents from the menu bar. o o | @@ Hep
] = R g |@+‘ Open Help for Start Panel F1
= How to Access Help 3
Start ]
@q One Point Advice...
LA g Tutorial
@] Browse Renesas Electronics Microcontrollers Web
2@ Privacy Settings..
Creat (i Detail Version Infermation...
,'Jé‘r'« About...

For information about the RX24U group microcontroller refer to the RX24U Group Hardware Manual.
For information about the RX assembly language, refer to the RX Family Software Manual.
Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright
This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of

this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2016 Renesas Electronics Europe Limited. All rights reserved.
© 2016 Renesas Electronics Corporation. All rights reserved.
© 2016 Renesas System Design Co., Ltd. All rights reserved.
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